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Version 10.0 Update Supplement 

Installing the New Version of Pulsonix 

It is always recommended that you back-up all libraries, designs, technology files, profile files and 
report files before installing the latest version. Other than for any technical reason, this is good 
working practice, although you should already have a backup of this data! 

To install Pulsonix, double-click on the download executable and wait for a short time. You may have 
been supplied a CD, in which case insert it and wait for it to run. The Autorun facility will start the 
installation procedure. Follow the on-screen commands from the install wizard. You can install 
Pulsonix 10.0 on top of your existing V9.0 installation. If upgrading from V9.0 or V9.1, you can 
install it alongside the older version if you prefer. In any case, you do not need to uninstall the old 
version first unless you wish to remove it from your hard drive. 

Licensing 

Version 10.0 requires a new license if a new user or upgrading from any older version of Pulsonix. 

If you are using a version of Pulsonix earlier than Version 9.0 or 9.1, you will require a new license, 
this would have been supplied to you under the terms of your maintenance contract. 

For existing users upgrading from a previous version, it is recommended that you save the new 
license and overwrite the existing one. When requested during installation, simply click the No 
Change In Licensing check box on the licensing page of the installation wizard. The License 
Manager can be used to add new licenses and make changes to network licensing after the 
installation has been completed. 

Version 10.0 Update Notes 

Update Notes for Version 10.0 are available in the Pulsonix installation folder under \documents. 
Alternatively, select the direct link within the product itself: Help menu | Online Manuals> 
Pulsonix V10.0 Updates Notes 
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New In Version 9.1 - Not Previously Documented 

The feature(s) below appeared in Version 9.1 but were not documented. They have been added here 
for your reference: 

Page Link Attribute on Blocks and Block Ports 

You can now use the page link attribute on Blocks and Block Ports to show the name of the page 
they link to.  

A new option on Design Settings and Naming page enables you to show the Page Number instead 
of the Page Name on a page link. 

 

Page link on block showing Page Number Page link on block showing Page Name 

  

Save configuration Files - Speed Increase When Saving Over Network 

A significant speed increase has been made for when saving your Configuration files to a network 
location. The speed is equivalent to that when saving the file locally now. This was added to a later 
version of Pulsonix 9.1 
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Intelligent Gerber Import option - Add unmatched drill holes as pads 

 
With the Add unmatched drill holes as pads check box selected, the import option tries to match 
drill holes (in the drill file) with pads/flashes in the Gerber file. This enables data that has holes only 
but no pad, such as mounting holes, to be imported. 

If the drill doesn't match a pad, it adds a pad for the drill hole even when it doesn't match a pad in the 
Gerber, otherwise a pad won't be added (and so no hole). 

Component Search Engine 

The Component Search Engine web site enables you to search Parts (along with Symbols and PCB 
Footprints) and download them to your Pulsonix application ready to use. Not only do they appear on 
the end of your cursor but are also automatically added to your library to use on another design. 

Product Version/Build Requirements 

You will need to be running Pulsonix 9.1 Build 6871 onwards to benefit from the Component 
Search Engine integration. This feature also runs will all version of Pulsonix 10.0 and later. 

Registering with Component Search Engine 

To use the Component Search Engine, you will first need to register an account.  

Go here - http://pulsonix.componentsearchengine.com/ and click Register. 

http://pulsonix.componentsearchengine.com/ and click 
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Downloading the Library Loader 

Once you have registered, you are automatically logged in. You now need to download the Library 
Loader application. This is required as the interface between the Component Search Engine web site 
and the Pulsonix application. 

Click on the Downloads button at the top of the Component Search Engine web page. 

 
On the Downloads page, scroll down to the Library Loader section. 
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Click the Download Library Loader button to start the download. 

Once downloaded, run the LibraryLoaderSetup.msi program from your download folder.  

 
Once the Library Loader has been successfully installed, open the Library Loader from your 
Windows Start menu. 

You will be asked to either Register or Login. As you have already registered you can select the 
Login Tab and Login using your User Name and Password.  

 
Once logged in, you now need to click the Settings button on the Library Loader dialog, this will 
open the Pulsonix Settings. 

  
From within the Pulsonix Settings dialog, you need to inform the Library Loader which version of 
Pulsonix you are using. If using 9.1 onwards, you will now be able to set the destination for where 
new Step Models, Schematic Symbols, PCB Footprints and Components (Parts) will be saved to. 
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Note: you need to be using Pulsonix 9.1 
(Build: 6869) onwards to have Parts 
automatically saved from the Component 
Search Engine into your Pulsonix 
Libraries. 

 

Now you’ve set up the Library Loader you can now download Parts from the Pulsonix Component 
Search Engine website and they will load directly into your libraries and onto the end of your cursor 
ready for placement in a design.  

Using the Pulsonix Component Search Engine 

From the Pulsonix Component Search Engine website 
(http://pulsonix.componentsearchengine.com/), enter the name of your Part or a description of it in the 
Search section. Once the search is complete you will see six columns presented including an ECAD 
Model, Datasheet and Pricing/Stock information for the Part from various suppliers. 

Clicking the Price/Stock link will allow you to select and download the Part with pre-populated 
attributes from a specific supplier.  

 
Clicking the Download ECAD Model button will download the model from the website into your 
libraries and onto the end of your cursor ready for placement in the design. Attributes are 
automatically added to the Part depending on the section you download it from, therefore if we click 
Download ECAD model from Farnell, we would then also see the Farnell Part Number on the part in 
Pulsonix.  

http://pulsonix.componentsearchengine.com/), enter the name of your Part or a description of it in the 
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Now the Part has been downloaded, you can investigate its attributes from the Edit Part dialog to see 
it has inherited the values from the online model, including the Supplier name and Suppler Part 
number.  

 

Updating Imported Parts to Company Standards 

It is always worth remembering that imported parts may need to be updated to your company 
standards. For example, this may mean adding attributes to Parts or changing text, pin and line styles 
on Symbols and Footprints to be in-line with your other library items. 

This concludes the instructions for using the Pulsonix Component Search Engine.  

Component Search Engine and Pulsonix in Dual Screen Mode 

If you are using Pulsonix in Dual Screen mode, the Component Search Engine will automatically 
place the component symbol in the ‘First’ screen.  
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To change which environment you would like the Search Engine to place the symbol in, go to 
Pulsonix, Options dialog, Multi-Screen tab and click Swap.  

 

Closing the Library Loader Application 

As the Library Loader will run in the background, you will need to close the background application 
if you wish to close it completely. To do this, select the up arrow on your taskbar, select the 
Library Loader icon and from the menu displayed, click Exit. 
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New In Version 10.0 - Not Previously Documented 

The following features are new to Version 10.0 and have been added since the first release was 
created. 

Accel Netlist Import – Part Mapping Dialog 

When reading an Accel Netlist into Pulsonix PCB using the Accel Netlist Import facility from the 
File menu, the Part Mapping facility has been added. This enables the Part name to be mapped from 
one used in the netlist to one from your library. 

Note: The import uses the originalName field in the compInst section in the Netlist for the part name. 

 
One first run of the dialog, if no mapping files already exists, press the Create button. This will read 
the Parts in the Netlist and ask you for a name to save the mapping file to. You can edit the Parts with 
the dialog displayed. 

 
The Browse and Edit buttons enable you to choose an existing mapping file or edit an existing 
mapping file. 

Note, the mapping file is an ASCII forms based file and can be edited if you understand the format 
and are careful. 

Netlist Output to SiMetrix Spice Simulator 

For users who have independently purchased SiMetrix Spice, there is now a specific output to write a 
netlist for the SiMetrix and SimPlis products. This is an extended version of the standard Spice netlist 
and is formatted for use with these simulators. 

From the Simulation menu and Set Netlist Spice Type, use the Spice Netlist Type drop down option 
and select SiMetrix. If the Run Simulator check box is selected, it will populate the command line 
switches for you. 
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Current Selection Mask Shown on the Status Bar 

The current Selection Mask being used is now shown on the Status Bar. Double click on it to choose 
a mask.  

Once selected, it will display <None> if no mask being used (where the Enable Selection Mask 
switch is selected off in the main browser window), or <Default> if the default setting is being used 
or User_Selection which will be a named user-defined selection mask. 

 
You can control whether it is displayed on the Status Bar by using the Show Mask on Status Bar 
switch on the main Selection Mask bar. 
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STEP Output – Settings Menu Change 

In the release version of Pulsonix 10.0, there was a change to the Output STEP dialog which meant 
that the settings switches were moved from the main front dialog to an inner Settings tab of the 3D 
Settings dialog. This hadn’t been previously documented. 

 

STEP Output – Define Silkscreen Layer 

Previously, the STEP output was looking for the key word Silkscreen when outputting silkscreen data 
into the STEP file or STEP Preview window. This meant that if your silkscreen layer wasn’t named 
‘silkscreen’ or perhaps was been written in a different language, the silkscreen would not appear in 
the file. This has been replaced with the ability to define the Silkscreen Layer Class using the drop 
down list box displaying the Layer Class names in your Technology. 

 

Fillet and Mitre Corners for Differential Pairs and Bus Route 

When using the Interactive High Speed option, you can now Fillet corners on a Differential Pair and 
Bus route.  

Differential Pairs - Fillets 

The ability to Fillet and Mitre corners in a Differential Pairs has been added. 

Interactive Differential Pair Routing 

During the routing of Differential Pairs, from the context menu, you can select the new Segment 
Mode of 45 Degree (Fillet) to created filleted corners. 
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Existing Differential Pairs 

With an existing Differential Pairs created, by selecting an existing mitred corner or the whole path 
(using Shift-select), you now have the ability to add Fillets to the corners. 

From the context menu, two new commands exist, Auto Mitre Selection and UnMitre Selection. 
The Auto Mitre Selection option will use the settings from the Technology file, Parameters, Auto 
Mitre page. 
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Bus Route – Fillets 

Interactive Bus routing 

When interactively Bus routing in PCB, you can now switch to the new segment mode 45 Angled 
(Fillet) using the option from the context menu. 

 

Existing Bus Routes 

With an existing Bus route created, by selecting an existing mitred corner or the whole path (using 
Shift-select), you now have the ability to add Fillets to the corners. 
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From the context menu, two new commands exist, Auto Mitre Selection and UnMitre Selection. 
The Auto Mitre Selection option will use the settings from the Technology file, Parameters, Auto 
Mitre page. 

 

   

ODB++ Output includes Profile Cutouts 

In the ODB++ format, the board outline is defined and drawn as a ‘Profile’. The new switch Include 
cutouts in the Profile will enable the output to also apply Cutouts to the board (Profile). Some of the 
later versions of the ODB++ viewers have the ability to read cutouts in Profiles. 
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CAM Plots – Auto Generate Plot Ordered By Variants 

Within the Schematic editor, in the CAM Plots option, there is a new switch in the Auto Generate 
Plots dialog to choose to generate plots and to Order by Variant. 

 

Report Maker 

Rotation of Attribute Command 

You can now report the Rotation of an Attribute position.  

Rotation will output the rotation of the displayed attribute. This is the real rotation value, not the 
adjusted value for readable text. This will be reported in the rotation units and precision defined in the 
Units dialog.  

Rotation (Transformed) will output the rotation of the displayed attribute with any design 
transformation applied also. 
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Indent & Unindent Commands 

From the main Report Maker dialog, there are two new buttons on the right side of the pane for 
Indent and Unindent. 

 

Indent 

Use this to add indentation to a set commands. Indentation can be used for a couple of reasons: 

· To add clarity to a portion of commands in a script. It might be a long IF statement that you 
need to indent to view clearer. 

· By Indenting a section of script, even commands outside of IF and ELSE statements, 
perhaps commands that follow the IF statements, such as End Of Line and Blank Line, you 
can then opt to Copy the commands or move them to another part of the script.  

When the Indent button is pressed, after typing in a Comment into the dialog, you must select the 
portion of script required for indentation. This is an interactive command so drag the mouse up and 
down to select the portion of script required.  

 



22   Pulsonix Version 10.0 Update Notes 

The comment is displayed in the script along with an indentation indicator.  

 
This shows the indentation indicator: 

 
The indent can then be 'closed' up to further aid clarity of your script. The Comment is still displayed 
in the script. 

 

Unindent 

Use this to remove the Indented status on a selected set of commands. 
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New In Version 10.0 

The following documentation details features specifically for Version 10.0. 

 

Technology Dialog Changes 

Enhanced Technology Dialog 

The Technology dialog has been further enhanced with the inclusion of Colours, Units, Grids, 
Variants, Design Settings, Naming, Adjacent Nets, Advanced Router Parameters, (base) Router 
Parameters, Autoplace Parameters, Auto Gate/Pin Swap and Auto Mitre Parameters. 

 
In addition to existing design facets, such as Colours and Units, version 10 also adds new 
functionality for auto-naming of style when required. Naming has been added under Naming for 
Hatch Styles, Line Styles, Pad Styles, Text Styles and Track Styles. See below for more details. 

This means that many design Technology contents are now in one location.  
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Technology Dialog Tree Structure 

You can now open and close all tree structures in the Technology dialog from the context menu. 

 

New Style Naming pages for the Technology Dialog 

Style Naming Dialog 

As a switchable option, you can opt to have Pulsonix automatically create style names for you. This 
means that, for example, when creating new pad styles, you could use the auto-naming option to use 
the IPC naming convention. 

Style Naming is available for all Styles within the Technology. 

Each page works like any other Rules page within the Technology except that generally speaking, 
you’d only ever have one or two rules for each naming style. 

 
The edit portion of the dialog is used to define specific naming items, this varies for each item style. 
The right side of the edit pane defines the Rule that will be created. Once the rule has been defined 
using keywords selected from the Field: drop down list, use the Insert button to add it to the Rule. 

 
Buttons on the Navigation bar under Replace All: enable you to add a rule to the rules pane replacing 
any existing rules. A button on all pages (Basic Set), is used to set up a basic rule for you to use. This 
can be edited to your own style if required. On the Pad Style Naming page, an extra button (IPC Set) 
is used to define a more complex string for the IPC naming rule. 

Basic Set & IPC Set Buttons 

On each of the pages is a button named Basic Set. On the Pad Style Naming page, there is an 
additional button for the IPC Set. These buttons are under the heading Replace All: and are used to 
create you a basic style naming rule tailored for each of the particular styles. As it says, using this 
button will add you one style naming rule to the grid and will remove all other rules defined. The rule 
won’t be applied until the Apply or OK buttons are used at the bottom of the dialog. 
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Note: When using the IPC Set button, this also sets up the Settings dialog as well as the rule 
definition. The IPC rule is a combination of both the rule and pad style/usage mappings. 

Style Naming Settings Dialog 

Each of the Style Naming dialogs has a Settings button. Each one is the same except for Pad Style 
Naming which has additional settings that can be used. The Settings dialog defines the Units and 
Units Text for the Style Naming. This is independent of the main Design Units dialog and is only 
used for Style Naming. 

The standard Settings dialog looks like this: 

 
The Pad Style Naming Settings dialog also enables additional Mappings for Shapes and Pad 
Usage.  
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This is used where specific styles require mapping so that can be correctly defined, the IPC naming 
style for example. 

 

Technology Styles Dialog 

In addition to the Style Naming dialog for each of the styles, the actual Style page has been modified 
too to enable the naming. 

Under each of the Name: fields for the style, there are now three additional radio buttons to define 
how the style will be Named by: There is a choice of Typed (manually named), Rule (using the new 
Style Naming rules for that style item) and Template (which is a hybrid, a combination of both Rule 
and Typed). 
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Technology General/Defaults Dialog 

From with the Technology dialog and Design Settings, General/Defaults page, there is an additional 
switch related to Style Naming called Make named styles use naming rules. When selected, this 
will force the addition of new named styles use the naming rules. Leaving it unchecked enables a 
Typed rule to be defined. 

 

Spacing Check of SMD Pads & Micro-vias 

As with Pads, Mounting Holes and Vias, you can now set Spacing rules for SMD Pads and Micro-
vias. 
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Pad Exceptions By Layer Class & Inner Electrical layers 

You can now create Pad Exceptions by Layer Class and for Inner Electrical layers. Both options 
are available when using the By Layer option and Exception Type: field for a selected Pad Style in 
the Technology dialog. 

 

Acid Trap Rules 

To facilitate additional functionality and checking, the Design Spacings page has been changed in the 
Technology to add spacing rules for Acid Traps under the Tracks tab. This checks for acid traps 
between Track segments and between Tracks and Pads. 

 
An acid trap is considered to be an acute angle created between design items, usually tracks and pads 
(as demonstrated below). 

  
As well as the detection of acute angles (less than the Minimum Allowed Angle defined), the angle 
also represents calculated angles based on tracks closer than the gap between the pad and the 
offending segment. This is defined as the Minimum Allowed Gap. 
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There is a new Acid Trap check box on the DRC dialog under the Manufacturing section. 

 

Enclosure Spacing Rules 

To facilitate the changes within the 3D STEP Preview, the Design Spacings page has been changed 
in the Technology to add spacing rules for Enclosures. This is discussed below in more detail in the 
3D STEP Changes section. 

 

Select Net Names by Attribute 

There is a new Select button on the Net Names page of the Technology dialog. 

 

Minimum Allowed Gap 

Minimum Allowed Angle 
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Once your Match: is chosen, pressing OK will make the matching selection in the Net Names grid. 

 
You can then use Apply to selected cells on the context menu, to, for example, set the colour of all 
nets with a matching attribute. 

 

Variant Manager now a grid Dialog 

Along with the inclusion of the Variants option within the Technology dialog, this dialog has now 
been changed to be grid based similar in style to the other Technology pages. 

 

 
Initially in a design, variants will not be in use. Press New to create the first variant. This will 
automatically create the <Master Design> entry in the Variants List. This entry is always at the top 
of the list and cannot be deleted while other variants exist. 
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Each press of the New button will add a new variant to the list. Select a variant from the list and 
check the Current button to make the one the current variant. 

New Variants Button 

Note, the Use Variants button has been removed. Adding a New variant will enable variants for 
designs with no variants currently defined. 

New Adjacent Nets Rule 

There is a new rule under Technology, Rules – DFM/DFT called Adjacent Nets. This allows you to 
set up rules to control what nets are checked against each other, check a net against a board outline 
and check a net against all items not on a net; that is, nets that match the rule and are within an 
optional tolerance. You may use this to check for nets that are inside the Spacing Rules defined but 
where you require knowing the closest item to the net being checked. 

Options on this dialog control how many warnings are generated and whether the set of nets is 
checked as a whole, or each net checked individually. 

Warnings are listed separately in the Errors bar and cannot be locked. 

 

 
With the flexibility of Pulsonix, the rule can be defined very broadly, such as all nets to all nets, or it 
can be defined more specifically, such as Net Name XXX against Net YYYY on Layer X. 

Additional rules can be also defined to refine the rule depending on your requirement. 

The general rule without the extra check boxes selected will select use a basic adjacency rule. 
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Checking the Check Against Board check box enables checking between nets and the board outline. 

 
Checking the Check Each Individual Net will check every net pair combination in the two sets, and 
not each set of nets as a whole. 

 
Selecting the Within Tolerance will define a tolerance value, so that only near points less than that 
tolerance are reported. 

 
Maximum Warnings For Each Net - this check box enables you to define the maximum number of 
warnings that each net can produce. Enter a value between 1 and 10. A large value may cover your 
design with warnings, meaning they are difficult to resolve. If there are many warnings, you should 
check your spacing rules.  

Adjacent Nets Checks in DRC Dialog 

A new check in Nets section of DRC dialog has been added for Adjacency Nets. This reports the 
closest points of adjacent nets with a warning marker. This check runs in its own thread. 

Adjacent Nets in Report Maker – List of Errors 

Report maker can detect the Adjacent Nets errors in a List of Errors command by using the Is 
Warning command. You can report the net names using the new Item1Name and Item2Name 
commands. 

Define Pad Shapes now on Pad Styles dialog 

As well as the Define Pad Styles option on the Setup menu, it has now been included as a button in 
the Technology dialog under Pad Styles. 
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Design Settings now in Technology Dialog 

Design Settings Menu 

Design Settings are now included as part of the Technology dialog. They are listed under their own 
menu item, Design Settings. 

 

Defaults Pages 

In the Technology dialog, Design Settings menu, Defaults pages are now available on the Defaults 
button which is on the General/Defaults page. 

 

Grids now in Technology Dialog 

Grids Menu 

Grids are now included as part of the Technology dialog. In the Technology, Grids menu, Current 
Interactive Grid is now replaced with Interactive Grid. 
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Grids Displayed Switches 

There is a new switch in the Grids dialog, Only During Editing. 

 
With Grids Displayed checked, when Display Interactive Grids Only is checked, the new Only 
During Editing switch decides what happens when in select mode. If Only During Editing is 
checked then when in Select mode will display all grids that are marked as Displayable (as it did in 
previous versions). If unchecked, select mode will display the interactive grid. 

Locked Grid Origins 

The ability to lock a grid to an origin of a particular type has been added. With the Lock check box 
selected, if the origin is moved, the grid will automatically update to be relative to it still. 

 

Apply Origin To All Grids 

A new check box labelled Apply Origin Settings To All Grids has been added under Grid Setup 
dialog. All grids will take on the settings from a grid the check box is applied to, e.g. Working grid 
can use a Locked Coordinate that is then applied to all other grids. 
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3D STEP Preview Changes 

The 3D STEP engine (STEP Preview), interaction, preview and environment within Pulsonix has 
been significantly reworked for Pulsonix 10. 

 

Gradient Background (switchable between Solid and Gradient) 

The background can now be switched from a single solid colour to a gradient background between 
two colours defined in the 3D View Settings dialog under Colours. You can setup the colours prior 
to viewing your 3D Preview from the Output menu, OUTPUT STEP dialog and 3D Settings, 
Colours tab, or from within the STEP Preview from Setup menu, 3D Settings, Colours tab. 

 
Both the Background colour and Gradient colours can be defined. Without the Gradient check box 
enabled, just the Background colour chosen will be used as a solid colour. With the Gradient check 
box selected, the background will be graduated between the background colour and the Gradient 
colour from the top to the bottom of the screen. 
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Improved Visualisation of the STEP Preview 

As a visualisation improvement generally for the 3D Preview, anti-alias rendering on models has been 
introduced. This provides smoother edges and a more realistic look to the design. In addition, the 
lighting of the design has been improved to add to the realism. 

Print option in STEP Preview 

The Print option has been removed from the File menu and a Save As Image option has been added 
instead. 

Toolbar with Icons of Pre-defined 3D Views 

Within the 3D STEP Preview, there is now a toolbar containing pre-defined 3D Views available for 
selection. Views have been provided (moving from left to right across the toolbar) for Axonometric, 
Front, Back, Left, Right, Top and Bottom. 

 
For the perspectives used in Axonometric view, please see below under Perspective and 
Orthographic Views. 
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Perspective and Orthographic Views 

For the Axonometric view, you can switch between Perspective and Orthographic Views 
depending on your preference. This can be changed from the Setup menu in the 3D environment and 
View tab or from the PCB design, Output menu, STEP, 3D Settings, View tab. 

 
Note: when the perspective is changed, this is only applied when you next run the STEP Preview, it is 
not changed for this Preview session. A warning to say this is issued when the perspective is changed. 

Rotation of Design in STEP Preview now on Right Hand Mouse button 

Rotation of the design in the STEP Preview is now done using the right-hand mouse button with 
the Ctrl button also pressed. Previously, this was done using the left-hand mouse button. The 
movement of this command to the right-hand mouse frees up the ability to select items using the left-
hand mouse (this is discussed below in more detail). 

Selection of items in STEP Preview on Left Hand Mouse button 

Using the left-hand mouse button, you can select both components and enclosures when they have 
been checked as selectable from the Setup menu in the 3D environment and Interaction tab or from 
the PCB design, Output menu, STEP, 3D Settings, Interaction tab. 

 
With this option enabled, if the mouse is moved over the either a Component or enclosure within the 
STEP Preview a wire frame selection colour will be added to the item. 
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If you use a single click of the mouse over the model, the model movement axes are displayed 
indicating the movement options available to you. This is displayed if the Component or Enclosure is 
marked as Selectable on the Settings, Interaction dialog. 

Components will be able to move in an X and Y direction, whereas enclosures can be moved in X, Y, 
Z and Rotational axes.  

 

Move Component on Grid in STEP Preview 

There are two settings for moving Components in the 3D STEP Preview; on the Component Grid 
and without. The default mode is for the movement to be on the Component Grid (as defined in the 
PCB design). It is recommended not to change this setting. 
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Moving Components in the 3D Preview will use the Component Grid defined in the PCB. This is 
dynamic, meaning that if the grid is changed in the PCB (with the 3D Preview still enabled in another 
window), the grid step will change in the 3D Preview to match. Likewise, if you change the PCB grid 
to use another grid, such as the <Working> grid instead of the <Component> grid, this will now also 
be reflected in the 3D Preview and be used. 

As an application note, you may find it easier to move Components within the Top view perspective 
rather than a 3D view. 

Automatically Synchronise 2D PCB from 3D 

You can opt to have Component and the Enclosure positions that are changed in the 3D Preview 
automatically made back in the 2D PCB view. 

To do this, select the Automatically Synchronise 2D check box on the Interaction tab of the 3D 
Settings dialog. By default, this will be enabled. 

 

Working in both 2D and 3D Environments 

If you intend working in both the 2D PCB environment and 3D Preview at the same time, and moving 
components around you should be aware of the following: 

- If Components are moved in the PCB, then the 3D Preview must be regenerated (close it, then 
regenerate using the Output menu and STEP Preview). 
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- If Components are moved in the 3D Preview, then provided the Automatically Synchronise 2D 
check box on the Interaction tab of the 3D Settings dialog is checked, then the component 
move will be automatically reflected in the PCB without doing anything else. 

If adding Enclosure STEP models within the STEP Preview environment, these are also back 
annotated to the PCB design. 

Enclosure Spacing Rules 

New Design Spacing Rules are available for Enclosures. These are defined in the PCB design and 
transferred to the STEP Preview when the dialog is opened. 

Spacing rules available for Enclosure to Board, Enclosure to Components and Enclosure to 
Enclosure will be used when the design is transferred into the 3D STEP Preview and used for clash 
reporting. 

 
See below under Clash Detection within the 3D Environment for how the Spacings are used. 

Adding Mechanical Enclosures 

Mechanical enclosures in STEP format can be included along with the Board and Components (using 
STEP models). There is a new Enclosures page in the 3D View Settings dialog of the Setup menu 
when within the STEP Preview to add Enclosures or other STEP models that are not defined as 
Components to the STEP Preview. You may also add more than one enclosure to the design for use in 
the Preview. This is also available from the PCB design, Output menu, STEP, 3D Settings, 
Enclosures tab. 

 
On selection of the New button, the Position STEP Model dialog is displayed. This will allow you to 
add a new or additional STEP models: 
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If you select a model from the list, the Edit button will allow you to edit its position. 

The Transparency of these STEP models is taken from the 3D Settings, Colours dialog. Colours 
used are available on the Colours button which are replicated from the 3D Settings, Colours dialog. 

Transparency Setting for Enclosures 

With the introduction of Enclosures and additional STEP models that are not Component related, you 
can set the Enclosure Transparency so that when overlaid on a board with Components, you can see 
the contents inside the enclosure. This is set on the 3D View Settings dialog under Colours. 
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Colour Setting for Enclosures 

Where enclosures are used and they have no colour defined of their own (this is normal as some are 
defined as neutral), there is a default colour setting that will be used by Pulsonix. On the 3D View 
Settings dialog and Colours, there is an Enclosure colour that can be set. 

 

Clash Detection within the 3D Environment 

To use the Clash Detection feature within the STEP Preview, you must first enable it, then enable the 
options you wish to detect. These options are available in 3D View Settings dialog and Interaction 
under Use Clash Detection. 
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If using the STEP Preview as simply a preview of the board, you may wish to switch off both the 
Selectable setting of Components and Enclosures and the Use Clash Detection options. 

 
See below under Using The Clash Detection Option for information about using this option. 

Using the Clash Detection Option 

Once the Clash Detection option has been enabled (in 3D Settings, Interaction, Use Clash 
Detection, see above), you can detect clashes using one of two options: 

- Interactively move Components or Enclosures 

- Or you can use the Detect Clashes option from the Tools menu 

Once clashes are detected, they are highlighted in red. 

To un-highlight clashes, select the Remove Clash Highlights from the Tools menu. 

Colouring for non-coloured STEP Models 

Where STEP models used for Components have not had their colour defined in the model, which 
some don’t, Pulsonix will add a colour for you. Choose the Components colour under the 3D 
Settings and Colours tab. 
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Properties of Selected design items shown on Status Bar 

For selected Components in the design, basic Properties (Component Name and Part Name) will 
be displayed on the Status Bar. It also shows you that a Component has been selected. 

 

Speed Increase of STEP file Generation through Multithreading 

With the introduction of multi-threading capabilities within the STEP file generation process, with 
drill holes selected, there is a significant speed increase. On large files tested, a speed increase of 
between 80-95% has been recorded. Obviously, the content of the design and the entities being 
exported will make a difference to the speed. 

STEP Model to Footprint Alignment 

The STEP option in the Design Settings dialog, General/Default page has changed from where it 
showed STEP and No Model Transformations to this below: 

 
Checking the 9.1 No Model Transformations option had two effects: 

- Ignored the <STEP Offsets> and <STEP Rotations> attributes attached to Parts or Footprints 
when aligning a STEP model to a footprint. 

- Stopped the automatic alignment of a STEP model to a Footprint by using bounding box centres 
(or Model Placement Areas) 

In Pulsonix 10, the Snap by: values will have the following effect: 

- Centres - will align the Footprint and the model using bounding box centres in the same way as 
in Pulsonix 9.1 without the No Model Transformations check box selected. 
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- Origins - will align the origin of the Footprint with the (0,0) in the model without reference to 
bounding boxes or areas in the same way as in Pulsonix 9.1 with the No Model 
Transformations check box selected. 

The Use Adjustment Attributes option will effectively do the same as above in 9.1 and ignore the 
<STEP Offsets> and <STEP Rotations> attributes, regards of the Snap by: value. 

3D Package Built-in Attribute 

The <3D Package> attribute is used to override the normal method of finding a 3D package based on 
the footprint name. There has been a subtle change made for V10 is to detect an empty value for this 
attribute indicating that there should be no 3D component displayed on the 3D view. This allows you 
to suppress any attempt to display a 3D image for particular components such as edge connectors 
when they aren’t required. 

Note: when the 3D Viewer is used under normal circumstances, unless specifically required, the <3D 
Package> attribute will not be used on a Component or Footprint as it is automatically mapped from 
the footprint name.  

Selection Mask 

The new Selection Mask toolbar allows you to choose design items that are selectable within the 
design and save the mask for subsequent reuse. This is available in both the Schematic and PCB 
design editors. 

This new option is available from the View menu and from the custom menu enabled by right 
clicking on any of the Pulsonix framework (enabled the same way as the Design Browser, Part 
Browser, World View etc.). It can also be enabled by right clicking on any of the existing open 
Browser windows and selecting it from the context menu. 
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Using the browser dialog 

You can use the Selection Mask on a task by task basis or you may prefer to create a selection mask 
and save it for subsequent use. 

You can create a list of selection masks that can be defined and saved. You might create a number of 
selection masks for all Track and Pads for example. 

To activate the Selection Mask and start to use it, select the Enable Select Masking check box. 
Without this selected, nothing happens. Initially, the <Default> selection mask is shown. This is the 
selection of check boxes in the list as currently set. If you change the selections and press the Save 
button, this then becomes the new <Default> selection. However, you may wish to be more specific 
about your choices and to reuse them.  

You can save multiple named selections by pressing the New button. When this button is pressed, the 
Create New Selection Mask dialog is displayed. When the Create button is pressed, the selection 
mask is saved. Using the Copy Current Selection Mask will enable you to make the selections, then 
save them. You could also use this to make slight modifications to an existing selection mask and 
save it to another named selection. 

 
The drop down list on the Selection Mask dialog displays all previously saved Selection Masks 

 

Check box options on the Selection Mask Dialog 

There are additional filters to enable refinement of the selection. With Pads selected, selecting the 
Additional Mask Parameters enables the Pad Style drop down list from where you can choose a pad 
style. This can a specific pad style or can be a wildcard name. The Wildcard wizard helps you create 
the name. 
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With a Pad style selected, you can then only choose pads that match that style. 

Updated User Interface 

4K Graphics Support 

New icons have been created to enable 4K monitors to be supported. The new icons are scalable and 
will be automatically resized when Pulsonix detects the use of monitors that require the new icons. 

As part of the 4K update, the use of graphics within Technology dialogs and other dialogs/wizards 
has also been resolved.  

Simplified Default Toolbars 

As part of the improved user experience, the default toolbars have been simplified by removing non-
essential icons. If you have migrated from an older version of Pulsonix (9.1, 9.0 or previous), you will 
need to reset the toolbar icons using the Customise option (from the Tools menu), Toolbars tab and 
Reset All button. 

You will also see that menus have been decluttered with the removal of non-essential icons. These 
icons are still available for use within a customised toolbar if required. 

More Readability for Read Only Edit Boxes 

Non-editable and read only edit boxes now have a set disabled colour to differentiate from edit boxes 
that can be changed and those that can’t. This makes their editable status more obvious when using 
high resolution monitors. 
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In the example dialog below, it can be clearly seem that entries such as Name:, Position: and Angle: 
can be edited, whereas the Part Name, Description and Part Family can’t. 

 

Design Attributes in Variants 

Design level Variant Attributes can now have different values in each variant (as well as a fitted 
state). These are accessed through the Edit menu and Design Properties.  

 
The Design Attribute must first exist, this is defined on the Attributes page of Design Properties. 

 
Each Variant instance for the attribute, in our example above, Global Title, can be edited to display a 
different value. 
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For each attribute it can also have a different Fitted status 

Interactive Copper Pour Healing 

The ability to ‘heal’ copper pour areas dynamically after edit has been added. The healing process 
will only heal poured regions when damage has occurred due to the edit. This may be caused by a 
track being moved into it or a pad being dropped in an area of poured copper. 
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This feature can be switched on or off using the Interaction dialog in Options. By default, it will be 
enabled. 

 

Changes to Manual Routing Modes 

Segment Modes 

The existing Segment Mode menu items used for manual routing and Differential Pair routing have 
been adjusted to make them more obvious. All modes now displayed on the menu were already 
available previously but have now been expanded into individual ‘modes’ with a more verbose 
description. 

The previous Orthogonal Mitre and Curved Mitre sub-options for the Orthogonal Mode have 
been replaced with new segment modes Orthogonal (Mitre) and Orthogonal (Fillet). 

Also, the Angled segment mode has been renamed to 45 Angled, along with a new mode called 45 
Angled (Fillet) that adds a fillet to every 45 degree corner. 

Fillet modes are different to Curved in that they provide a smooth transition between angled 
segments. 

 
These modes are also available for use during Differential Pair routing if you have the Interactive 
High Speed option on your license. 
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Edit Mitre Mode 

There is a new Any Angle check box in Interactive Mitre/Fillet section of the Edit Track and Edit 
Shape options pages.  

 
Checking this box to allow the Edit Mitre option (often assigned to Double-click on a corner) to 
mitre or fillet between straight lines at any angle between them.  

 
Leave it unchecked to only allow mitres between lines orthogonal and perpendicular to each other. 
This does not affect the Mitre Corner or Auto Mitre options. 

Design Rules Checks Dialog Changes 

New DRC Checks - Acid Traps and Adjacent Nets 

Two new checks have been introduced for Acid Traps and Adjacent Nets.  
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Both options are described in more detail under function headings, but in summary: 

Acid Traps is a check defined in the Design Spacing Rule dialog under the Tracks tab. This rule 
defines both the distance of a track to a pad and checks for acute angles. 

A new check in the Nets section of DRC dialog has been added for Adjacency Nets. This reports the 
closest points of adjacent nets with a warning marker. The adjacency rules are defined in the 
Technology dialog under Rules – DFM/DFT. 

Clear Warnings Option 

As some of the new options such as Adjacent Nets, report warnings and not errors, the DRC dialog 
has a check box to enable you to clear existing warnings (Clear Warnings) when DRC is run. 

 

Automatically Open DRC Errors Bar Switch 

An extra button has been added to the DRC dialog to automatically open the DRC Errors Bar. 

 

Attribute Editor Changes 

Footprint Name in Edit Attribute Dialog 

The Attribute Editor has been made more consistent across all areas where it is used; in the 
Schematic and PCB design editors and within the Library Manager on the Parts page. All column 
fields such as Part Name, Description, Family, and Footprint Name have been made available 
where they were previously missing.   

 



 Pulsonix Version 10.0 Update Notes   53 

Hide Inbuilt Columns 

You can now quickly hide the inbuilt columns (except the Name column). The Hide Column option 
is available from the context menu on the column header. To show columns again, choose the field 
required from using the Column Visib button on the controls panel. 

  
In addition, the Part Description and other standard fields are now on all Part based grids. 

Reload All – Do Not Reload Doc Symbols 

You can now choose not to Reload Doc Symbols when doing Reload All. This is useful as Doc 
Symbols are not relevant to the Synchronise Designs process. 

 

New Commands in Options Dialog 

Middle Mouse Wheel/Button Usage Options 

On the Interaction page of the Options dialog, there is a new check box Rolling Wheel Does Zoom 
In/Out. 

With this option checked (the default state), the existing zoom in/out behaviour will be used. With it 
unchecked, the wheel does Pan Vertical and Pan Horizontal if Shift is pressed. If Ctrl is pressed it 
will do a Zoom. 
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Also on this dialog is a new option to suppress the Pan facility of middle mouse button when the 
check box is unchecked. The default state is for the check box to be selected to do a Pan using the 
middle mouse button. 

New Component Pads Selection 

Within the Options dialog and Select page, there is now an extra option enabled when using Select 
Whole Components. Check the new Select Component Pads option to allow selecting of visible 
Component pads. Uncheck it to have the whole Component selected when picking pads, subsequent 
shift-select on the pad will change the selection to just that pad. 

 

Create PCB Group for SCM Block 

You can now mark a Block instance (using Block Properties) to have a group in the PCB. 

The equivalent group is added to the PCB and Synchronise Design will keep them in-line. The group 
has the same name as the Block, with an optional prefix (which is defined in the PCB, see below). 
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Block Name Prefix 

If required, set the Block Name Prefix for use in the PCB from the Technology dialog, Design 
Settings – General/Defaults and Defaults button. Choose Block and type the name of the Block 
Group Name Prefix: 

When viewed as a group, the name will look like this, showing the Prefix first, followed by the Block 
Name. 

 

Join Open Shapes 

The Join Open Shapes option has been added to enable you to select multiple open shapes and then 
join them into a single shape. This is useful in a number of situations; where shapes have been 
imported from another system, DXF for example, and because of tolerances of the exported DXF, the 
shape ends do not meet. The second instance can occur when a design is imported from another 
system. As with the DXF import, this new feature allows you to join segments which have become 
dis-connected. 

If the shapes to be joined form a complete loop with no crossing lines, the resultant shape will be 
closed. 

This option is available for Doc shapes in Schematic, Symbols and PCB designs. It is also available 
on Copper in PCB designs. 

Join Tolerance Value 

To enable a more accurate joining of shapes and to allow for variations in data, there is a new Join 
Tolerance factor on the Interactions page of the Options dialog. This is used to determine if the 
shape ends are close enough to be joined.  



56   Pulsonix Version 10.0 Update Notes 

 
Note: there is already a tolerance built into the importer, in some instances, this is not ‘large’ enough 
to cope with the joining of segments. The tolerance is a very small value, you may need to adjust your 
design Units precision to 5, 6 or lower decimal places to be able to view and set the join tolerance 
value. 

Save Doc Symbols To Appropriate Library 

You can now save Doc Symbols to the appropriate library when doing Save To Library or when 
dropping an individual design on to the Library Manager. This includes Parts, Footprints/SCM 
Symbols, PCB Doc Symbols/SCM Doc Symbols depending which type of design you are currently 
editing. 

 
You can also save all library items from a design in one go by using Save To Library from the 
context menu with nothing selected.  
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Changes to Error Markers 

Error Markers that refer to a single point, such as Single Pin Net or Unfinished Track for example, 
now have an indicator drawn to show that point. Previously, no specific marker was drawn, this is 
now an X with a circle around it at the error origin along with the error marker letter. 

 

Find will Find Areas with no name 

In PCB, you can now use Find Area to find unnamed areas using the new <No Name> entry. This 
will list both unnamed Component Areas and ‘free’ Areas within the design. 

 

Find Bar Changes to Select All Find Items 

Within the Find Bar, small change have been made to Select All Find Items and Select Visible Find 
Items. Previously, they did not deselect anything before use, now they will deselect all before use 
unless the Ctrl key is held down during use. 

Dynamic Starting for PCB Bus Routing 

PCB Bus Routing will now add and move tracks from the start items to the moving bus start indicator 
on-the-fly, whereas in the previous release it was only when you clicked to start adding the bus 
segments. 
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As the images below show, once started, if the Bus routing start items move down, the start tracks 
dynamically move to reroute. 

  

New Template Option – Clear On Edit 

There is a new Template option – Clear On Edit . This is available on the Options dialog and 
Interaction tab. With this enabled, it will remove poured copper when editing the Template. 

 

Library Manager Changes 

Resizable Library Manager 

All pages within the Library Manager can now be resized. As with all other resizable dialogs, use 
the corner grabber to resize the dialog. 

 

Part Pin Mismatch Report 

In the Library Manager Parts dialog a new report has been added to Check For Pin Mismatch. 

This looks at the expected pin count of a Part and finds and checks against the pin counts on the Parts’ 
Footprints and Schematic Symbols to look for a mismatch. This takes into account Connectors 
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typically having a single pin symbol for all its Parts. It will also inform you if it simply can’t find the 
Symbol or Footprint the Part references. 

 

STEP File Names in Part Details 

Within the Library Manager and Parts page, the Part Details tab now has a list of STEP Files 
associated with is as defined in the Part Attributes. It defaults to the STEP file attribute on a Part, 
however if it doesn’t find one associated with the Part, it will search through the Parts’ Footprints and 
will display the STEP file if it has one associated with it. 
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Clear Filter 

A new button to Clear the Filter entries in the Library Manager has been added. This works the 
same as clearing the Filter box and/or No Pins box and pressing apply but is much quicker. 

 

Custom Indexing for Footprints 

Footprint Type 

The PCB Footprint Wizard now gives you the option on the Finish page to attach the ‘type of 
footprint as an attribute to the footprint. 

 
The footprint ‘Type’ or ‘kind’ is taken from the PCB Footprint Wizard Type page using the Type 
selected for creation: 

 
When the Footprint created is subsequently edited, the Footprint Type attribute will be available in 
the Design Properties along with its value. This will be an editable value if you need to update its 
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Type. Likewise, if you wish to categorise any of your existing Footprint library footprints, this 
Attribute and Value can be added using the Attribute Editor. 

 

Custom Footprint Indexes 

You can now Index more than just the pin count. This is now similar to the Parts indexing where you 
can index any Attribute name available or a custom Attribute when typed. When the Index button is 
selected on the PCB Footprints page, this dialog is now displayed: 

 

Using the Footprint Type 

With the Footprint Type now in the footprint definition, you can now use it in the Parts index. When 
indexing your Parts, chose Footprint Type or type Footprint Type and then re-Index the Parts. Once in 
the Parts index, it can be used for categorisation within the Parts Browser for example. 
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Manual list Refresh in Library Manager 

A new Refresh button has been added to all pages of the Library Manager and including the 
Folders page. This allows you to manually refresh the contents lists. This would be used when 
manually adjusting the library environment that the Library Manager does automatically know about. 
For example, if you manually remove a library file that has previously been accessed because it is 
within the library search path. In this instance, the refresh option will re-search the library path. 

 

‘Follow Item’ on a Part option 

The ability to follow a Part to a new library has been added. With the Follow Item check box selected 
on the Move or Copy Library Item dialog, this will action the option, then when copying or moving 
the Part will open the Part on the new library and select it in the Contents list. 

 

Find Symbol 

The Find Symbol option has been added Schematic Symbol Library page. This new option allows 
searching of symbols that fit certain criteria or match a preselected criteria using a symbol referenced 
from the list. 

This dialog can work in two modes, the first is from a pre-selected Symbol name off the symbol 
contents list on the Schematic Symbol Library page, the second is as a Custom Search using defined 
criteria. 
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The Find Symbol option can take parameters passed through on specific, Symbol: name selected 
from your library. As the name is pre-selected from the Contents list in your library, it is not editable 
here. Parameters are displayed on this dialog, extracted from the symbol, such as Pins on the Symbol 
Layout.  

Alternatively, by selecting the Custom Search check box, you can define your own parameters.  

The Find Symbol tool will generate a value for the Part you have selected in the Library Manager 
page, these values will represent the pin layout in relation to the Symbol selected. The values 
represent the number of pins and in which direction they are found in relation to the Symbol.  

At this point you can perform two types of searches all with different results based on the search 
options and criteria. By default the tool will run a simple 'pin match' basic search.  

Check boxes on the dialog allow various parameters to be defined, these are used to add extra filtering 
the search. 

Find Footprint 

A new Find tool has been added to the PCB Footprint Library Manager page. This allows 
searching of existing Footprint libraries and reports matched items. 

Footprints that fit defined criteria or match a preselected Footprint name from the list. 
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You can make a search for a particular footprint in open libraries by pressing the Find button from 
within the PCB Footprints tab of the Library Manager with a footprint selected. Or you can search 
for a user defined number of pads and copper shapes by entering the find tool with no selection or by 
clicking the * button next to the name of the footprint.  

The Find Footprint tool will generate pad values for the footprint you have selected in the Library 
Manager page, these values will represent the pad count, copper shape count and styles present in the 
Footprint selected.  

At this point you can perform different types of searches all with different results based on the search 
options and criteria.  

Find Footprint in 3D Packages 

Within the Library Manager under 3D View page, a new Find button has been added.  This enables 
you to search for Footprints that are referenced by the 3D Packages. 
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Rename in Library Manager – Replace Symbol References in Parts 

In the Library Manager under the Rename button for SCM Symbols and PCB Footprints, there is 
a new check box for the Replace References feature. This will find and then enables you to replace 
all references of the old symbol name with the new symbol name in your open Part libraries. 

 

Swap Symbols Option 

Within the Parts Editor page of the Library Manager there is a new Swap Symbol button. 

This enables you to find and replace all references to an old symbol name or multiple symbol names 
and to replace it with a new name in your Parts library. 

It also gives you the option to add an alternate footprint to Parts that contain an existing one (e.g. 
parts containing footprint x can have y added to their footprint list as an alternative).  

 
Optionally choose to add the swapped Footprint or Symbol as an Alternate symbol in the Parts 
Library. Selecting this option will force it to check the footprints you are adding using a pin count 
match before adding them as alternatives in the found Parts.  

Select the This Library Only option to only make swaps in the current selected Parts Library. If All 
Libraries has been selected in the Parts Library dialog, this check box will be greyed out as not 
available. With a single library selected in the Parts dialog, the search will search and swap (where 
applicable) in all libraries unless this option is selected.  

Select the Delete Old Symbols When Done option to delete the old symbols once they have been 
found and replaced in the Parts library.  

Select the Generate Report option to report any changes and to report the success of name 
replacements when the option is run.  
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Search 

On selection of the Search button, when the search is complete, you will be presented with a list of 
Parts that use the Footprint or Symbol and the relevant Parts libraries. From the list, you can choose 
which items to replace before continuing. The search will be made on an entered Footprint or Symbol 
name defined as Old Name or by using the results of the Load Report option.  

The OK button will start the process and replace all references to the previous Footprint or Symbol 
with the new names. If the new name list has more items than the old name list you have entered, the 
Swap Symbol option will replace all Parts with the single new Part name. This enables you to swap 
out the symbols to multiple old Parts with a single new Part.  

Load Report 

You can enter a comma separated list of Parts to use as your search and a comma separated list of 
parts to replace them with.  
You can also use the Load Report button to open a 'Similar Symbols to (X)' report produced 
through the Find Symbol option on the PCB Footprints or Schematic Symbols tabs of the Library 
Manager. This will use the perfect match option to fill the old names list for you. When you have 
entered the Parts to search for, click the Search button. A progress will show the progress of the 
search. The search is NOT case sensitive, however it requires the Part name to be exact, including 
spaces, otherwise the name will not be found.  

Be careful when using this tool as no check is made to see if the replacement Footprint or Symbol is 
actually available, unless using the option with footprints to add alternative footprints.  

Create New Libraries directly from the Library Manager Folder tab 

There is an additional button on the Library Manager Folders dialog. The New Library button 
allows you to create all five library types at once with the same name (SCM Sym, SCM Doc Sym, 
Parts, PCB Footprints and PCB Doc Sym). These empty files can then be populated as required using 
the various methods. 

 
All five library types are saved at the same time using the Save As dialog: 
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Part Description Using Substitute Attributes 

You can now create a ‘dynamic’ Description field for a Part using Substitute Attributes. This can be 
done in the Library Manager when editing a Part (using New or Edit). 

The Description field can be created from Attributes that appear in the Part definition. The format of 
the name will be: 

Syntax: Res_Value (%%Value%%) with the resultant value displayed as: Res_Value (10k)  

The Parts Attributes field would look like this: 

 
The Parts Details page will show an edited Description field like this: 

 
When the Part is used in the design, the Component Description field is populated with substituted 
values. 

 

CAM Plots – Drill Output available for Board Outlines & Cutouts 

In the CAM Plots option, for a Drill output within the CAM Plot Wizard, you can now add board 
outlines and area board cutouts to the drill output. 

On the Output page, there is a new option to select Boards: From here, you can choose None, All 
Boards, Cutouts Only and Outlines Only. 
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All Boards - means all board outlines including Area Board Cutouts,  

Outlines Only - does not include Area Board Cutouts or Cutouts Only (only Area Board 
Cutouts). Area Board Cutouts can be plated or non-plated, and these are selected using the Drill 
Type above.  

Select None to prevent any Board outlines being output. 

CAM Plot – Plot String Attribute 

You can optionally provide a Plot String on a CAM Plot output. This is used to satisfy any Attribute 
Positions of type <Plot String> placed on your design. This could be used to define a reference 
number or other identifier on your output. 

When adding an attribute position to the design, if you select <Plot String>, the value cannot be added 
here but is instead, added when the Plot String is satisfied in the CAM Plot dialog. 

To define the Plot String, it can be added using the CAM Plot Wizard or directly in the CAM Plot 
dialog. 
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Whatever value you type in the Plot String box will be added to the plot once output. This is plotted at 
the <Plot String> attribute position. 

Export IPC-2581 - Omit BOM Data 

When exporting the IPC-2581 netlist, there is now a new check box, Omit BOM Data. This is only 
displayed when choosing a Fabrication output which normally would contain BOM data but enables 
it to be removed for security reasons and protection of design IP. 

 
This feature has also been back fitted to Pulsonix 9.1 

Toggle True Width For Layers 

Alan 01/06/18  - Yes 

Added a command to toggle true width for all layers. This is available on the context menu of the 
Layers Bar. 

 

Report Maker Changes 

Access Other Tables in PDC Database 

Report Maker – Database Value 

Within the Report Maker option and the List of Components command, the Database Value 
command now has an extra ability. As well as reporting the database value from the current 
Component you can now use it to report a value from a related Component using the required 
Component’s key value identifier. 

This is done by specifying a variable name that at run time will contain the key value identifier for the 
alternative component. For example this identifier could be taken from an attribute on the Component 
being reported.  
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Use Alternative Database Identifier From Variable 

Check the Use Alternative Database Identifier From Variable check box and then provide the 
Variable name from the drop down list. 

 
This command has also been back fitted to Pulsonix 9.1 

Adjacent Nets in Report Maker – List of Errors 

Report maker can detect the Adjacent Nets errors in a List of Errors command by using the Is 
Warning command. You can report the net names using the new Item Name and Second Item 
Name commands. 

This might be used like the example below: 

 
This would report a message like this: 

Adjacent Nets (AN) Between (57.800 22.496) and (43.800 31.196). Layer 
'Top'. Actual 16.483 
Code: AN 
Net1: PG0 (57.800,22.496) 
Net2: PE5 (43.800,31.196) 

Another example to report adjacent net rule errors might be like this: 
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High Speed Option Changes 

Differential Pairs - Turn Backwards direction on Via Pattern 

When swapping layers with Differential Pairs, the Via Pattern selectable can now be Turn 
Backwards. This means, once the layer swap has been made, the pair will turn back on itself. 

 

 

Improved Accuracy of Differential Pairs 

Improved tightness of Differential Pairs on a Layer Swap 

During Differential Pair editing, when applying a Layer Swap, a predefined pattern is added. In 
version 10, the accuracy and ‘tightness’ of the shape of the tracks around the via pattern when using a 
Parallel style has been significantly improved. 

 

Diff Pair tightness and accuracy 
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Acid trap removal using Minimum Allowed Gap Spacing Rule 

During Differential Pair routing, when performing a Layer Swap using the Parallel pattern, the Acid 
Trap rule defined will be used. Using a combination of the Minimum Allowed Angle and the 
Minimum Allowed Gap, you can control the removal of acid traps. 

These values are defined in the Technology dialog under Spacings, Design Level and the Track tab. 
Under the Acid Traps rule, you can change the values of the Minimum Allowed Angle and 
Minimum Allowed Gap to that required. 

  
To utilize this fully, an angle entered for the Minimum Allowed Angle will control the acid trap 
removal to ensure that the track entry to the via will conform to this rule. If you require additional 
control, you can specify the Minimum Allowed Gap also. This will mean that if the angle is violated, 
the track will then be backed off by the gap defined. If the gap is set to zero, the minimum required to 
remove the violation will be applied. 

Improved Differential Pair Routing – Fillet Mode 

While routing Differential Pairs, you can now switch Segment Mode to use one of the two new 
additional routing modes: Orthogonal (Fillet) and 45 Angled (Fillet). 

 
When using 45 Angled (Fillet), you can produce Differential Pair tracks with smooth filleted corners. 

 

Potential acid traps 
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Fillets can also be applied to Differential Pairs on existing tracks that were routed previously by 
selecting the corner and using Edit Mitre from the context menu. The Mitre used (45 degree or Fillet) 
will depend on the setting using from the Tools menu, Auto Mitre, Auto Mitre All. Both Curved 
Mitres and Any Angle should be enabled. 

 

Improved Differential Pair Routing – Mirror Diff Pair routing from Angled Components 

Differential Pairs can now be routed out of pads at any angle. 

  
 

Do this by start mirroring a Differential Pair track from two pads that are at an odd angle (not a 
multiple of 45 degrees), you will be presented with a warning dialog asking if you want to enter 
Restrictive Movement mode to add segments that are perpendicular to the line through the start pads. 

  
Choose Yes to do this. The restrictive movement angle will be automatically set and the track 
segments will be at the correct angle. If this is an operation you do often on non-45 degree 
components, then you can switch this message off using the check box on the dialog. 

Using this mode 

After cornering, the mode stays and you can turn in 45 degree steps relative to the start angle. When 
close together and you click, it will enter adding paired tracks still in the restrictive mode. Add a 
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segment or two and then use the context menu to switch Restrictive Movement off and now you can 
add the segments in your normal segment mode. 

Choose No to the dialog to add the mirrored segments in a direction that is a multiple of 45 degrees 
closest to where you clicked to start mirroring. (This is how Version 9.1 and previous versions 
worked). 

Note: Restrictive Movement mode always allows you to turn a multiple of 45 degrees now. In 9.1 
this only worked if you set the angle to zero. 

Finish Track On Differential Paired Track (Spur) 

You can now finish a single track on a Differential Paired track segment provided the track is not an 
arc and is on the same net. To allow this happen, in the Technology under Nets – Differential Pair, 
the pair must have the Allow Spurs rule enabled. 

 

With the single track over the Differential Paired track to connect to, on drop, it will unpair a small 
section of the segment and join the track to it. If you also have Optimise After Edit enabled in 
Options, Edit Track, the connection from the single track will be optimised automatically. 

 

New Serpentine Skew Modes on Differential Pairs 

Selection of single track on a differential Pair 

A change to the way in which Serpentine operates on Differential Pair routing has been made. 
When a single track segment of a Differential Pair is selected, when using the Dynamic Serpentine 
mode, regardless of the position of the cursor relative to the ‘other’ Differential Pair track, the 
Serpentine will now only be applied to the selected segment. Previously, the position of the cursor 
when in this mode dictated which track was selected from either pair. 

Serpentine Skew Modes on Differential Pairs 

Serpentine mode has been improved for Differential Paired tracks. There is now biasing, selectable 
from the context menu, to enable you to bias the track upwards so that the bottom track is not 
affected, to centre the bias around both tracks of the pair and to bias the serpentine track to the bottom 
and to have the bottom paired track move to allow space for routing. 
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Move All Vias in Composite Span 

When using the High Speed option and Composite Vias, there is a new option in Options under 
Move to Always Move All Vias In Composite Spans. This is only applied when a single via in a 
span is selected and move performed. This now defaults to a checked status to always be on so that 
the Composite Via moves as one unit. Uncheck it to get behaviour like version 9.1 where just the 
single selected via moves. 

 

Network License Server (NLS) Changes 

A complete rework of client-server interaction for network licensing has been undertaken for 
Pulsonix 10. 

On the server side: 
NLSD new application that does the actual licensing runs as service or application  
NLSM manager application that controls NLSD either on server or from another computer 
NLSL log viewer application used from NLSM as an easy way to view log files 

Client side: 
No visible change for clients, with all changes being within the client application itself. The separate 
PulsonixMonitor application that used to run as a hidden program to maintain the heartbeat signals 
to the server is now obsolete. A separate thread inside the main Pulsonix application now manages 
heartbeats. Performance is better from the client side, allowing quicker application startup time. 

The separate Network Licensing User Guide has full details about installation and management of 
NLS. 
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Default Supplied Technology Files Changes 

All Schematic and PCB Technology files have been set to the Basic Set for Style Naming Rules for 
Hatch, Line, Pin, Pad, Text, Connection and Track. 

All PCB Technology files have the ‘Footprint Type’ attribute added as Any Item, PCB Design Only. 

Unattended Installation 

The Pulsonix 10.0 installer has been modified to allow IT Managers of large networked installations, 
the ability to mirror an installation with ease across other clients. This uses the standard Microsoft 
network installation where an install set is pushed onto clients. 

An additional user’s guide named Pulsonix Unattended Installation.pdf is provided on the Pulsonix 
web site under documentation. 

 


